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How to Count Units 

 
The primary purpose of the Capital Fund Recovery Act Performance report is to capture data on units.  

Where the spreadsheet asks for unit counts related to modernization, one should count all units that 

are impacted by the modernization activity.  For instance, if a PHA is replacing the roof on a building 

that has 5 units, it is to count all 5 units in the unit totals reported on the spreadsheet.  If a PHA is 

modernizing common area space in a building (e.g. the lobby of a building or the hallway on a floor of 

a building), it should count all of the units in the building that are supported by the common area.  

Similarly if a PHA is modernizing a separate building that supports units (e.g. a building that provides 

water treatment or supplies heat for units in other buildings), it is to count all of the units supported 

by the facility.  A PHA should not count units as modernized if the PHA is spending its Capital Fund 

Recovery Act funds on a community center structure that is available for use by residents of the units.  

This instruction is repeated on page 14 of these instructions. 
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Opening and Saving the Spreadsheet Application 
 

The Capital Fund Recovery Act Performance Report will be e-mailed to you as an Excel spreadsheet 

application from a mailbox titled CapFundRecovery@hud.gov.  The spreadsheet will be named after 

your grant number.  In the following examples, the Anytown Housing Authority received grant number 

AT36S00150109.  Therefore, its spreadsheet is named AT36S00150109.xls.   

 

Upon receipt of this e-mail, you should save the attached spreadsheet file to your local computer or 

network (see Figure 1). 

 

 

Figure 1:  Position your mouse over the attached Excel spreadsheet and right-click and select “Save as”  to save your 
spreadsheet application. 

Locate the file that you just saved and then open the spreadsheet by double-clicking on it.  You may 

receive a warning message or alternatively be unable to open the spreadsheet because of the security 

setting in Excel.  If this happens, change your security setting to “Medium” and grant permission for the 

spreadsheet to run macros and Visual Basic code as described below.   

Right-click on the Excel 

spreadsheet attachment 

and then select “Save as” 

in order to save it. 

mailto:CapFundRecovery@hud.gov
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Figure 2:  If you see this warning, click "Enable this content" and then click "OK". 

The message box show in Figure 3 will display if the spreadsheet’s macros are unable to run because 

your security settings are too high.  Click the OK button to clear the box. 

If you see this security 

alert, you will need to 

enable macros so that the 

spreadsheet application is 

able to run. 
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Figure 3:  This warning indicates that your security level is set too high for the spreadsheet macros to function properly. 

To change your security settings, click on the “Tools” menu option, and then select “Options” (Figure 4). 

 

Figure 4:  Change your security settings in Excel by selecting Tools from the main menu, and then select Options from the 
Tools menu.  In the Options box, click on the Security tab to select it. 

This message box 

indicates that your security 

settings in Excel are too 

high.  Click OK to clear it. 

To change your security 

settings, select the Tools 

item from the main menu, 

then select Options from 

the Tools submenu. 

Select the Security tab on 

the Options box. 

Next, click on Macro 

Security. 
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In the Security box, click the radio button beside Medium to select it.  Click OK to close the Security box, 

and click OK again to close the Options box (Figure 5). 

 

Figure 5:  Reset your macro Security Level to Medium, then click OK. 

After resetting your security level, reopen your spreadsheet.  Again, you will receive a Security Warning 

about macros.  To continue, select the Enable Macros option (Figure 6). 

 

Figure 6:  Macros must be enabled in order for your spreadsheet application to work. 

  

Click the radio button 

beside Medium to reset 

your macro security, then 

click OK. 

You need to Enable 

Macros in order for your 

spreadsheet application to 

function properly. 
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The first screen on the spreadsheet application will resemble that depicted in Figure 2 below (the 

Stimulus Data Collection Application screen). 

 

Figure 7:  The first screen of the Capital Fund Recovery Act Performance Report application. 

Before you begin working with your application, you should save a working copy of the spreadsheet 

using the spreadsheet’s own save function.  To do so, click the Next button shown in Figure 7. 

 

The second screen of the application is shown below in Figure 8 (the List of Projects screen).  To 

continue saving a copy of the reporting spreadsheet to your Desktop, click on the Save button as shown 

in Figure 8. 

 

Click the Next button to 

proceed tp the next 

screen. 
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Click the Save button to 

continue saving the 

application. 

 
Figure 8:  The second screen of the Capital Fund Recovery Act Performance Report application.   

A message box will appear with instructions for saving and submitting the form.  The application will 

automatically assign a name to your copy of the Excel spreadsheet.  It is very important that you do not 

change the name the application assigns to the spreadsheet.  Click the “Continue to SAVE” button 

(Figure 9). 

 

 
Figure 9:  This message box instructs you not to change the name the spreadsheet has automatically assigned to itself. 

 

 
 

Figure 10:  Click OK to continue with the saving process. 

This screen warns not to rename the 

file.  Click the “Continue to SAVE” 

button to proceed. 

This dialogue will appear after you 

click the “Continue to SAVE” button.  

Click OK to continue. 



Capitol Fund Recovery Act Performance Report Instructions Page 8 
 

Click on the Desktop option on 

the left side of the Save As 

box. 

Click the Save button to save the 

spreadsheet to your Desktop. 

DO NOT CHANGE THE 

AUTOMATICALLY ASSIGNED 

FILE NAME! 

Next a “Save As” dialogue box will be displayed.  It is strongly suggested that you save the Excel 

spreadsheet to your Desktop where you can easily locate it.  To do so, click the Desktop icon on the left 

side of the “Save As” box, then click the Save button  (Figure 11). 

 

The Excel spreadsheet has now been saved to your desktop and will be available to you from there.  

HINT:  If you have several applications open, you can access your Desktop quickly by clicking the 

Desktop icon on the bottom left side of your Windows Taskbar (See Figure 12).  To open the application, 

double-click its icon on your Desktop. 

  

Figure 11:  Select the Desktop icon on the left side of the Save As box, then 
click the Save button to save a copy of the application to your Desktop. 
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Figure 12:  The Excel Recovery Act Performance Reporting spreadsheet is now readily available on your Desktop.  You can 
switch to your desktop quickly by clicking the Desktop icon on the left side of your Windows Taskbar. 

 

Working with the Spreadsheet 
 

To open the spreadsheet, double-click the icon on your desktop.  If the warning box depicted in Figure 

13 displays, click the Yes box to continue. 

 

 
Figure 13:  Click the Yes button to continue opening the application. 

 

The Excel spreadsheet is 

now readily accessible from 

your Desktop. 

You can switch to your Desktop 

quickly by clicking the Desktop 

icon in the Taskbar. 

 

Click “Yes” to continue. 
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The opening screen will display grant information specific to your Housing Authority (Figure 14).  Please 

review this information carefully.  The information is current as of the Grant Information date listed 

underneath the Grant Number.  You will not be able to change this information yourself.  If anything is 

incorrect, contact the Office of Capital Improvements at either the PIHOCI@hud.gov mailbox or by 

calling (202)708-1640.  

 

 

Figure 14:  This screen contains information specific to your Housing Authority's grant.  Please review it carefully. 

HUD is asking for you to fill in two pieces of information at the bottom of this screen where you are 

asked to enter grant funds that you project/estimate will be obligated and disbursed by December 31, 

2009 (Figure 15).  Obligation is defined as the amount that a PHA is obligated to pay pursuant to a legally 

binding contract or alternatively through the rules that pertain to Force Account work.  HUD 

understands that there is an element of uncertainty with respect to this information and is only 

requesting your best guess as to the status of obligations and disbursements as of December 31, 2009. 

After you have entered these amounts, click the Next button to proceed to the next screen.   

 

Make certain 

the grant 

information for 

your Housing 

Authority is 

accurate. 

mailto:PIHOCI@hud.gov
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Figure 15:  Enter the amount of grant funds you project will be obligated and distributed by December 31, 2009. 

On the next series of screens you will report on the modernization and/or development of units using 

Recovery Act funds for the public housing developments administered by your PHA.  On the next screen, 

you will be asked to select a development where grant funds will be spent (Figure 16).   

 

  
Figure 16:  On the List of Projects screen, select a development where grant funds will be used.  A new development can be 
added from this screen. 

If grant funds will be used for a development that was not listed in the PIC database when this 

spreadsheet was created (e.g. a new development), you should click the “Add A Development” button 

to record information for this new development (Figure 17).  If the funds for the Recovery Act grant on 

Select an existing 

development that will be 

modernized or developed 

using Recovery Act grant 

funds. 

Add a new development that 

has not as yet been recorded in 

the PIC database. 

Enter the amount of your grant funds 

that you project/estimate will be 

obligated by December 31, 2009. 

Enter the amount of your grant funds 

that you project/estimate will be 

disbursed by December 31, 2009. 

These amounts reflect the data in HUD’s 

LOCCS system as of the Grant information 

date.  You will not be able to change the 

amounts here. 
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which you are reporting will all be used on developments included on the List of Projects screen, you 

should not add a development. 

 

Figure 17:  Only add an unlisted development that will be receiving funds from the grant on which you are reporting. 

Note that Anytown Towers has been added to the list of available developments.  You can select it by 

double-clicking on it.  You may also select an item from the list by highlighting it, then clicking on the 

“View/Edit Selected Development Data” button.  See Figure 18. 

 

Figure 18:  Select a development from the List of Projects screen by double-clicking on it or by selecting the "View/Edit 
Selected Development Data" button. 

On the Enter Project Data screen (Figure 19) you will be asked to provide specific information about the 

modernization and/or development activity that your PHA is undertaking at the selected development.  

This screen contains three distinct areas for data entry.  The top part of the screen (referred to as 

Section A in Figure 19) requests that you provide information pertaining to existing units that will be 

If grant funds will be used for a 

new development that is not 

recorded in the PIC database, 

you should add it so you can 

report on it. 

The new Anytown 

Towers 

development is 

now available on 

the list of projects.  

One can select it 

by double-clicking 

on it, or by clicking 

this button 
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rehabilitated or modernized with grant funds.  The second part of this screen (Section B in Figure 19) 

asks you to provide data for new units to be developed with funds from this grant.  Finally, the third part 

of this screen (Section C in Figure 19) asks that you provide address information for a unit which is 

approximately at the geographic center of the area being rehabilitated, modernized or developed. 

 

Figure 19:  The Project Data screen asks you to provide specific information relative to the units where funding from this 
grant will be used. 

If grant funds will only by used to rehabilitate or modernize existing units, you will only need to fill out 

Section A and Section C.  In the event you will only be adding new units with funds from this grant, you 

would complete only Section B and Section C.  In the event you will be rehabilitating or modernizing 

existing units and adding new units with grant funds, you will need to complete all three sections 

(Sections A, B and C).  Figure 20 shows how a completed screen might look for new units being 

developed with grant funds. 

Section A 

Section B 

Section C 
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Figure 20:  This screen shows data for new units being developed with grant funds. 

Note that where the screen asks for unit counts related to modernization, one should count all units 

that are impacted by the modernization activity.  For instance, if a PHA is replacing the roof on a 

building that has 5 units, it is to count all 5 units in the unit totals reported on the screen.  If a PHA is 

modernizing common area space in a building (e.g. the lobby of a building or the hallway on a floor of 

a building), it should count all of the units in the building that are supported by the common area.  

Similarly if a PHA is modernizing a separate building that supports units (e.g. a building that provides 

water treatment or supplies heat for units in other buildings), it is to count all of the units supported 

by the facility.  A PHA should not count units as modernized if the PHA is spending its Capital Fund 

Recovery Act funds on a community center structure that is available for use by residents of the units.   

After you have added the requested data for the selected development, you may elect to print the 

information you have entered by selecting the “Print Page” button at the bottom right side of the 

screen.  When you are finished, press the “Back to Project List” button.  You will be returned to the 

Project List screen.  (See Figure 21.) 

Pressing the “Back to Project List” button also serves to retain the data you have entered.  Note that the 

value in the “Updated” column of the List of Projects screen will change from “No” to “Yes” for each 

development where you provide information (Figure 21).   

If a particular grant is funding modernization and/or development activity at more than one 

development, provide the required information for the first development and then select the next 

development until you have provided information for all of the developments where the PHA will be 

modernizing and/or developing units using Recovery Act funds for the grant on which you are reporting.   

Click this button to retain your 

data and to return to the Project 

List screen. 

The Print Page button will print 

the data you have entered for 

this development. 
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Figure 21:  When you return to the List of Projects, you will note that the "Updated" column reflects the fact that your data 
has been recorded. 

You can review or edit the data recorded for any development by highlighting it and double-clicking on it 

or by clicking the “View/Edit Selected Development Data” button.   

You may save your data and exit the application at any time by clicking the Save button on the List of 

Projects Screen (see Figure 21 above).  Continue with the Save procedures described in Figure 7 through 

Figure 11 above.  IMPORTANT:  While pressing the “Back to Project List” button retains the data you 

have entered into the spreadsheet’s memory, the spreadsheet itself is not saved until you follow the 

Save procedures previously described.   Any data retained in the spreadsheet’s memory will be lost if the 

application crashes or if your computer loses power.  However, following the Save procedures 

permanently saves the spreadsheet to your computer’s hard drive. 

Each time you save your application, a slightly different name will be assigned to it.  The part of the 

name that will change is that which appears after the underscore.  It represents the date and time you 

saved the spreadsheet.  For example, a file named AT36S00150109_119200944952PM.xls indicates that 

it is for grant AT36S00150109, and that it was saved on 11/9/2009 at 4:49:52 pm.  You will always be 

able to tell the most recent file by examining the file name. 

The screen shown below in Figure 22 shows 4 copies of the sample Anytown spreadsheet application.  

Only the first part of the file name is visible.   

The “Updated” 

column will change 

to “Yes” after data 

has been entered for 

a development. 

Click the “Save” 

button to save your 

edits. 
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Figure 22:  Only the first part of the file name is visible on the desktop. 

To see the last part of the file name, position your mouse cursor over the file name.  You do not need to 

click.  A file information box will appear (Figure 23).  The box displays the full file name, and also 

indicates the date and time the file was saved.  Move your mouse cursor over all the file names until you 

locate the most recent one, and then double-click its icon to open it. 

This Desktop has 4 different 

copies of the Anytown 

spreadsheet application. 
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Figure 23:  Position your mouse cursor over the file name to view the complete file name and the date and time it was saved. 

 You may reopen the spreadsheet and save your data as many times as necessary.  You need to 

complete the data entry process for each development where grant funds will be used. 

Returning your Completed Spreadsheet Application to HUD 

After completing your data entry, you will need to e-mail your completed Excel spreadsheet to HUD at 

CapFundRecovery@HUD.gov.  

Open your e-mail program and create a new e-mail message with CapFundRecovery@HUD.gov in the 

“TO:” line.  To attach your completed spreadsheet, click the “Insert” tab then click the “Attach File” icon 

(Figure 24). 

 

Figure 24:  Create a new e-mail message addressed to CapFundRecovery@HUD.gov, and then click the Insert tab and the 
Attach File icon. 

From the Insert File box, select Desktop from the items on the left (Figure 25).  Follow the procedures 

described above to identify the most recent copy of your spreadsheet application (Figures 22 and 23).   

To attach your spreadsheet to the 

e-mail, click the “Insert” tab. 

Click the “Attach File” icon, which is 

the first item on the Insert menu. 

By positioning the mouse cursor over 

the spreadsheet application icon, one 

is able to view the full file name as 

well as the date and time the file was 

saved. 
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Figure 25:  Select Desktop on the left side of the Insert File box.  Use the procedures previously described to identify your 
newest spreadsheet. 

When you locate the newest file, select it by clicking on it and then click on the Insert button.  Once you 

have completed attaching the spreadsheet to the e-mail message, double check that you have attached 

the correct version of the spreadsheet.  The e-mail will display the name of your spreadsheet file below 

the Subject line (Figure 26).   Note:  While the Subject line in the examples is “Completed Capital Fund 

Act Recovery Report,” you may put whatever is meaningful to you as the Subject. 

 

Figure 26:  The attachment appears below the Subject line. 

Click the Send button to e-mail your completed spreadsheet application to Headquarters. 

If you have sent the e-mail to the proper e-mail address, you will receive an e-mail acknowledgment of 

receipt within 24 hours.  If you do not get an acknowledgement from HUD, please double check the e-

mail address and resubmit your report. 

The name of the attached 

spreadsheet file will appear below the 

Subject line of your e-mail. 

Select Desktop on the left 

side of the Insert File box. 

Use the procedures 

described above to 

identify the most recent 

copy of your spreadsheet. 


